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 The immune system's primary role is to protect the host from infectious agents; 
however, its malfunction can lead to autoimmune diseases, wherein the immune 
system mistakenly attacks the body's own tissues. This research focuses on 
autoimmune hepatitis (AIH), a condition characterized by liver inflammation 
triggered by the immune response against liver cells, predominantly affecting 
women. The study examines the pathophysiology of AIH, highlighting the role 
of CD4+ T-lymphocytes and the cytokine interleukin-17 (IL-17) in mediating 
inflammation. Jaundice, a symptom of liver dysfunction resulting from excess 
bilirubin, is also explored, detailing its types and underlying causes including 
liver disease and hemolytic anemia. The research employs molecular docking 
techniques to investigate the potential of IL-17 inhibitors in mitigating 
autoimmune responses, emphasizing the importance of computational methods 
in understanding and treating autoimmune conditions. Furthermore, the paper 
discusses the role of serotonin in autoimmune inflammation and the therapeutic 
potential of selective serotonin reuptake inhibitors (SSRIs) in managing 
autoimmune diseases. This comprehensive study aims to elucidate the complex 
interactions between immune responses, liver health, and therapeutic 
interventions for autoimmune diseases.         
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INTRODUCTION 
 
The immune system is developed to fulfil the primary function of protecting hosts from infectious agents. 

This system get collapsed it leads to produce autoimmune disease. [1,2] Autoimmune disease is a condition which 
is trigged by the immune system initiating an attack on self-molecules due to the deterioration of immunologic 
tolerance to auto-reactive immune cells. [3] They are pathological conditions identified by abnormal autoimmune 
responses and characterized by auto-antibodies and T-cell responses to self-molecules by immune system 
reactivity. [4] Nearly 80% of women are affected with a chronic autoimmune condition. [5] Some of the 
autoimmune diseases are Type 1 Diabetes, rheumatoid arthritis, autoimmune hepatitis, Grave’s disease, Crohn’s 
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disease, Sjogren’s disease and lupus. [5,6] Autoimmune hepatitis (AIH) is defined as the inflammation of liver 
due to the body’s immune system attacks the liver cells. It may cause in any age people at unknown time period 
which is mostly caused in women more than men. [7,8] The autoimmune hepatitis is caused by the CD4+ T-
lymphocytes cells. AIH is also caused by the jaundice. [8,9] The word Jaundice is derived from the French word 
“Jaune” means “yellow”. [10] Jaundice is defined as a yellow discoloration of the body tissue resulting from the 
accumulation of excess bilirubin. Deposition of bilirubin happens only when there is an excess of bilirubin and 
this indicates increased production or impaired excretion. [11] This condition is also known as hyperbilirubinemia 
which is known as high level production of bilirubin in the body. [12] The normal level of bilirubin is less than 1 
milligram per deciliter (mg/dL). [11] 80% of bilirubin is formed by the breakdown of hemoglobin in senescent 
red blood cells and prematurely destroyed erythroid cells in the bone marrow. The remaining 20% of bilirubin 
formed from heme-containing proteins such as myoglobin, cytochromes, catalase, peroxidase and tryptophan 
pyrrolase which are found in other tissues, primarily the liver and muscles. [13,14] Bilirubin is produced from the 
breakdown of haemoglobin. The heme oxygenase enzyme catalyst the heme at the alpha carbon bridge and gets 
separated into iron, carbon-monoxide and biliverdin. [15] The heme is an iron-containing porphyrin found in 
hemoglobin, myoglobin and several enzymes of which the hepatic cytochromes are the most important 
representatives. These are breakdown in the reticuloendothelial systems of spleen, liver and marrow where iron 
is removed from the heme molecule and the remaining porphyrin ring is oxidized and cleaved at a single site to 
form the tetrapyrrole chain structure of bilirubin. [10,16] Jaundice may develop in all age peoples and is normally 
result of an underlying condition. Newborns and older adults have the highest risk of developing jaundice. [17]   
 

SYMPTOMS 

The well-defined symptoms of jaundice and autoimmune hepatitis are,  

• A yellow color in skin, mucus membrane and whites of eye.  
• Dark urine and clay / pale colored stools.  
• Flu-like symptoms.  
• Itchy skin and weight loss.  
• Reduced appetite, fatigue and vomiting.  
• Stomach pain, chills and fever. [17-20]  

 

CAUSES 

• Mostly by viral infections.  
• Cancer in liver, bile ducts or pancreas.  
• Gallstone disease, cirrhosis, alcohol consumption, hepatitis, hemolytic anemia. [17-20] 

 

TYPES OF JAUNDICE  
Hemolytic Jaundice: 

• Causes: Increased production of bilirubin due to the excessive breakdown of red blood cells.   
• Mechanism: The liver cannot process all the bilirubin produced from the breakdown of red blood cells.   
• Examples: Hemolytic anemia, sickle cell disease, or thalassemia.  

  
Hepatic (Hepatocellular) Jaundice 

• Causes: Liver dysfunction that impairs bilirubin processing.  
• Mechanism: The liver cells are damaged or inflamed, affecting their ability to metabolize bilirubin.   
• Examples: Hepatitis, cirrhosis, alcoholic liver disease or drug induced liver injury.  

  
Post-hepatic (Obstructive) Jaundice:  

• Causes: Obstructive of bile flow from the liver to the intestine.  
• Mechanism: Bilirubin cannot be excreted into the bile ducts and accumulates in the blood.   
• Examples: Gallstones, pancreatic cancer or strictures in the bile ducts.  

  
These classification help in diagnosing the underlying cause of jaundice and guiding appropriate treatment 
strategies. [17-20]   
                        

  



M. Manjula et al / Int. J. of Pharmacy and Analytical Research. 14(1) 2025 [135-145] 

 

137 

 

Pathophysiology Of Auto Immune Hepatitis 

The exact route cause of AIH is unknown, but the current report states that environment triggers the 
cause of immune failure and leads to T-Cell inflammation.   

                                                       ↓  
T-Lymphocytes recognize the antigen and activate the T-cell. 

↓ 
Tumor Necrosis Factor (TNF), IL-17 (Interleukin-17) are secreted by activated T-cells and it involves in the 

produce INF- γ (Interferon gamma) to macrophage activation. 
↓ 

Binds to the JAK-STAT (Janus kinase-signal transducer and activator of transcription). 
↓ 

Cause Inflammatory Response. 
  

● Generally Thymus gland mature the T-lymphocytes which is originated from bone n marrow.  
● It differs into two T-cell lineages with different functions in immune system.  

 

TYPE-1 
(γδ Lineage – Role of surveillance cells of immune system)   
 

TYPE-2   
 (αβ Lineage – Role in develop of different phenotype)   

• From Cluster of Differentiation-4 (CD4 +) CD8 + Double positive cells and CD4-CD8-Double negative 
cells to CD4 + or CD8 + Single positive cell are differentiated.  

• This above cells can express the surface membrane molecule and involves in recognition of antigen, 
proliferation, activation, differentiation function of T-cells.  

• IL-17 also secreted by the γδ T-cells.  
• The cytotoxic granules and granules in released directly into the infection cell by the γδ T- cells to kill the 

infection cells.  
• A study reported that IL-17 can promote the expression of chemokines and activation of macrophages in the 

site of inflammatory. [21]             
          

 
 

Th17 cells, a lymphocyte subpopulation that is characterized by the expression of the transcription factor 
“Retinoic Acid Receptor-Related orphan Receptor Gamma-t (RORgamma-t), Plays major role in the pathogenesis 
of autoimmune disease. Th-17 cells not only play role in host defence against bacterial and fungal infection but 
also in may immune related disease such as RA, Multiple sclerosis, Inflammatory bowel disease. [23]  
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Role of Th17 cell in inflammation 

  
CLINICAL TRAILS 
Inject intracerebrally lymphocytic choriomeningitis virus usually causes a lethal lymphocytic choriomeningitis in 
mice.  
● T-cell mediate the disease while T-cell deficient mice survive after the injection administration.  
● Hence T-cells plays major role in inflammation in metabolic disease.  [21]  
  
LIVER BIOPSY 
The typical auto immune hepatitis biopsy includes mono nuclear inflammatory infilterate mostly plasma cell, 
located in portal ducts.   
Piecened necrosis of hepatocytes caused by this inflammation, leads to destruction of hepatocytes.   
This hepatitis leads to cause;  

▪ Fatigue.   
▪ Malaise.   
▪ Jaundice.  
▪ Arthrolgias. 

 
TEST 
The presence of anti-smooth muscle antibodies reports the Type-I auto immune hepatitis disorder.  Because it 
only found in AIH patients. 60% of patients have chronic hepatitis but they don’t have serologic evidence of viral 
infection.  [22]  
    

 
 Functions of T helper cells   
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METHODOLOGY 

 
MOLECULAR DOCKING   
It is a computational method to predict the interaction between two molecules with the help of AUTODOCK 1.5.7 
application.   
 

STEPS INVOLVED IN DOCKING 
Choosing the protein target and ligand molecule 

● Visit https://www.rcsb.org/.  
● Search for the required protein molecule.  
● Download protein file > PDB format.  
● Visit https://pubchem.ncbi.nlm.nih.gov/   
● Search for the required ligand molecule.   
● Download > 3D conformer > SDF > Save.  

    
Folder making 

● Open new folder and name it as docking.  
● Add the downloaded protein and ligand in it.   
● Copy the docking folder link.  
● Open autodock > File > Preference > Startup Directory > Make Default > Set.   

 

Preparation of protein 
● Drag the downloaded protein molecule from the docking folder.  
● Edit > Delete Water.   
● Edit > Hydrogen > Add > Polar only.  
● Edit > Charges > Add Kollman charges > Ok.  
● Grid > Macromolecule > Protein molecule > Select Molecule > Ok > Save it in pdbqt format.   

 

Preparation of ligand 
● Drag the downloaded ligand molecule from the docking folder.  
● Ligand > Input > Select molecules > Dialogue box opens > Ok.   
● Edit > Delete Water.   
● Edit > Hydrogen > Add > Polar only.  
● Edit > Charges > Add Kollman charges > Ok.  
● Grid > Macromolecule > Protein molecule > Select Molecule > Ok > Save it in pdbqt format.  

 
Grid process 

● Drag the protein molecule in it.   
● Grid > Macromolecule > Choose > Protein > Select molecule > Dialogue box > Ok > Save.  
● Grid > Set Map Types > Choose > Ligand > Select molecule.   
● Grid > Grid box > Box appears > Cover the protein and ligand by adjusting the dimensions x , y & z.   
● File > Output > Save > Save it as “grid. gpf”.  

             
Docking process 

● Docking > Macromolecules > Set Rigid filename > Select protein > Open.  
● Docking > Ligand > Choose > Click ligand > Select ligand.  
● Docking > Docking parameter > Accept.   
● Docking > Output > Lamarckian Genetic Algorithm > Save as dock.dpf > Save.  

 
Analyse 

● Analyse > docking > open dlg file > select > open > ok.  
● Analyse > macromolecule > choose > protein > select molecule > ok.  
● Analyse > confirmation > play,ranked by energy > show info.  

 
Save 

● Build current > ok.  
● Write complex > save as result.pdb[24].  
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Recent Molecular docking in IL-17 Inhibitors 
Recently FDA approved drugs in IL-17 inhibitor drugs Secukinumab, Ixekizumab and Brotalumab. 

The trails done in Molecular docking method by Yue, Chen MD in August 25,2023.  
  
DOCKING STUDIES 

REMOVAL OF HYDROGEN 
In molecular docking, hydrogen atoms are often removed from the ligand and protein structures for 

several reasons:  
1. Simplification 
Hydrogen atoms are small and have a relatively minor impact on the overall shape and properties of the molecule. 
Removing them simplifies the structure and reduces computational complexity.  
2. Focus on heavy atoms 
Docking algorithms focus on the heavy atoms (carbon, oxygen, nitrogen, etc.) that form the molecular backbone 
and functional groups. Hydrogen atoms are not as crucial for determining the binding mode.  
 3. Reducing degrees of freedom 
Hydrogen atoms add degrees of freedom, making the docking process more computationally intensive. Removing 
them reduces the number of possible conformations, making the calculation more manageable.  
4. Improving scoring function accuracy  

Some scoring functions used in docking are more accurate when hydrogen atoms are removed, as they can be 
sensitive to the precise placement of hydrogen atoms.  
 5. Standardization: 
Removing hydrogen atoms standardizes the input structures, ensuring that the docking algorithm is evaluating the 
same molecular features across different ligands and proteins. [25]  
 

ADDING KOLLMAN CHARGES 
 1. Simulate electrostatic interactions: Kollman charges help to accurately model the electrostatic interactions 
between atoms, which is crucial for predicting binding affinities and molecular recognition.  
2. Account for partial charges: Kollman charges represent the partial charges on atoms, which arise from the 
unequal sharing of electrons in covalent bonds.  
 3. Improve docking accuracy: By including Kollman charges, docking algorithms can better predict the 
orientation and binding mode of ligands to proteins.  
 4. Enhance scoring function accuracy: Kollman charges improve the accuracy of scoring functions used in 
docking, which evaluate the binding affinity of ligands to proteins.  
 5. Mimic physiological conditions: Kollman charges help to simulate the physiological environment, where 
electrostatic interactions play a significant role in molecular recognition. [26]  
Kollman charges are particularly important for:  

▪ Protein-ligand docking.  
▪ Molecular dynamics simulations.  

 

ADDING POLAR HYDROGENS 
1. Polar hydrogens are most relevant: Polar hydrogens are involved in hydrogen bonding, which is a crucial 
aspect of molecular recognition and binding.  
2. Simplification: Including only polar hydrogens reduces the number of atoms to consider, simplifying the 
calculation without sacrificing essential details.  
3. Focus on key interactions: By focusing on polar hydrogens, the simulation can concentrate on the most 
important electrostatic interactions driving binding.  
4. Reducing computational cost: Including fewer hydrogens decreases computational resources required for 
calculations.  
5. Balancing accuracy and efficiency: Adding polar hydrogens only strikes a balance between capturing essential 
electrostatic effects and maintaining computational efficiency.  
Polar hydrogens are typically defined as hydrogens attached to:  
Oxygen (O)  
Nitrogen (N)  
Sulfur (S)  
Fluorine (F)  
These hydrogens are more likely to participate in hydrogen bonding and are thus crucial for accurate simulations.  
[27]  
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ADDING COMPUTING GASTEIGER CHARGES 
1. Accurate electrostatic representation: Gasteiger charges provide a more accurate representation of the 
electrostatic properties of molecules, which is crucial for simulations and docking.  
2. Partial charge calculation: Gasteiger charges calculate partial charges on atoms, which is essential for 
understanding molecular interactions.  
3. Improved docking accuracy: Gasteiger charges improve the accuracy of docking simulations by providing a 
more realistic representation of electrostatic interactions.  
4. Enhanced scoring function accuracy: Gasteiger charges enhance the accuracy of scoring functions used in 
docking, which evaluate binding affinities.  
5. Standardization: Gasteiger charges provide a standardized way to calculate partial charges, ensuring 
consistency across different molecules and simulations.  
6. Compatibility with force fields: Gasteiger charges are compatible with various force fields, making them a 
widely accepted choice for simulations.  
7. Accounting for electronegativity: Gasteiger charges consider the electronegativity of atoms, which is essential 
for accurately modeling electrostatic interactions. [28]  
 

LAMARCKIAN GENETIC ALGORITHM (LGA) 
It is a variation of the traditional Genetic Algorithm (GA) that incorporates the concept of Lamarckism, which 
states that an organism can pass on characteristics it acquired during its life time to its offspring. [26]  
In the context of molecular docking, LGA is used to optimize the pose of a ligand within a protein binding site. 
In below states how it works:  
1. Initialization: A population of ligand poses is generated randomly.  
2. Evaluation: Each pose is evaluated using a scoring function, such as binding affinity or docking score.  
3. Selection: Poses with higher scores are selected for the next generation.  
4. Crossover: Selected poses are combined to generate new poses (offspring).  
5. Mutation: New poses are randomly modified (mutated) to introduce diversity.  
6. Lamarckian step: The best pose from the previous generation is used to "teach" the new poses, by applying a 
local search algorithm to optimize their binding mode.  
7. Repeat: Steps 2-6 are repeated until convergence or a stopping criterion is reached. [26]  
 

INSILICO MOLECULAR DOCKING  
                   In-silico molecular docking studies was performed for autoimmune disease of gout arthritis by 
polyphenols ligand against the interleukin 17A. The release of chemokines are inhibited by the binding of 
polyphenols with interleukin 17A which leads reduce the inflammation.  

Cytokines of the IL-17 family promote and maintenance of both adaptive and in-native immunity. 
Dysregulation of their production exhibit the inflammatory and autoimmune disease such as rheumatoid arthritis, 
psoriasis, asthma, autoimmune hepatitis. The release of neutrophils and macrophages mediated by interleukins in 
autoimmune disease condition.Interleukin-17A play a key role in production of T-helper cells (Th17), gamma 
delta T-cells (γ and δ) and natural killer cells. In present in-silico studies aimed to perform the potential inhibitory 
action of selected drugs against IL-17A.  

For gout arthritis (PDB:ID-4HRa) protein was used in molecular docking studies to report the action of 
polyphenols against IL-17A to inhibit the action. ADMET (Adsorption, Distribution, Metabolism, Excretion and 
Toxicity) studies aided by SWISS ADME severs.  [29] 
 
PLANTS IN IMMUNOSUPPRESSION ACTIVITY 

CD+4 T-cells differentiate into effector (Th1, Th2, Th3) cells and immunosuppressive cells upon 
antigenic stimulation in the presence of a specific cytokines.  Therefore an aqueous extract of T.Cordifolia was 
non-cytotoxic at concentration below 1500 microgram per milliliter that moderately inhibit the proliferation of 
CD+4 cells. It has the chemical constituent of glycosides that shows inhibition of the cytotoxicreceptor signaling 
pathway, majorly via the JAK-STAT signaling pathway.  [30]  
 

SEROTONIN 
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Serotonin, a biogenic amine, play a crucial role as a neurotransmitter. It was named serotonin after the Latin word 
serum and the Greek word tonic. It similar to epinephrine, nor epinephrine, dopamine and histamine.  
Serotonin is produced in two steps:  
1. The essential amino acids tryptophan hydroxylated to 5-hydroxytryptophan (5HTP) by tryptophan 

hydroxylase.  
2. 5-HTP is decarboxylated to form 5-HT Early pharmacologic studies demonstrated that hydroxylation and 

decarboxylation occur almost instantaneously in the presence of tryptophan.  
The cell bodies responsible for producing serotonin are organized into nine separate groups, which are 

predominantly found in the pons and midbrain areas.  he majority of the body's serotonin, approximately 90-95%, 
is found in the peripheral tissues, with the largest stores located in platelets and enterochromaffin cells.  
Nearly all of the body's serotonin, around 99%, is contained within cellular boundaries, indicating a stringent 
regulatory mechanism for this neurotransmitter. Animal models have been used to study its function in human, 
revealing its impact on various physiological processes. These include regulating gastrointestinal motility, 
peripheral and cerebral vascular tone and platelets function. Additionally, serotonin has been linked to several 
conditions, such as mood disorders, nausea and vomiting, migraines, irritable bowel syndrome and hypertension. 
Research on serotonin has led to the development of drugs that target the serotonergic system in humans and 
animals, including dogs and cats. However, the increased use of these drugs has also led to the discovery of a new 
toxicity affecting both humans and animals.  

Serotonin is a multifaceted molecule that exerts a wide range of effects throughout the body, including 
the central nervous system and peripheral tissues. It plays a triple role as a hormone, neurotransmitter and cell 
growth promotor and its presence is widespread across the animal kingdom. Serotonin was isolated and 
characterized in 1948 by Maurice rapport and Irvine page. The isolation of serotonin came after decades of 
investigation to characterized a vasoconstrictor substance that was suspected to be contained in platelets. The 
presence of serotonin was soon detected in a multitude of tissue, including the central nervous system, respiratory 
organs, renal system, blood platelets and the gut highlighting its diverse rule in human physiology. When serotonin 
was first identified, it was only the third known neurotransmitter, but subsequent research it involvement in a 
broad range of central nervous system processes, including emotional regulation, behavior control, sleep-wake 
cycles and food intake. [31] 
 

Mechanism of role of serotonin in autoimmune inflammation 

 
 

SELECTIVE SEROTONIN REUPTAKE INHIBITORS IN AUTOIMMUNE SYSTEM 
Selective Serotonin Reuptake Inhibitors are administrating for treating autoimmune pathogenesis and 

graft versus disease. The SSRIs are most prescribed drugs for the indication of depression, obsessive compulsive 
disorder, panic disorder and other lesswell established indication such as post traumatic stress disorder, obesity, 
eating disorder, social phobia and premenstrual disorders. They have more beneficial and less adverse effect while 
comparing with other antidepressants, because it is majorly used in treatment under certain circumstances 
increased suicide risk. [32] 

The drugs have some clinical observation in treatment of patients with depression and also conducted 
some invitro studies. It produces abnormal effects on viability of peripheral blood lymphocytes and cytokines and 
also in proliferation while exposed to Selective serotonin reuptake inhibitors. It also affect the viability of cancer 
cells and also its replication. [32]  

An overview were reported for selective serotonin reuptake inhibitors have some immunological effects 
on immune cells by conducting both in-vivo and in-vitro studies. The drugs reduce the lymphocyte proliferation 
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and inhibit the secretion of cytokines for prevent the inflammation. Therefore, the drugs of SSRIs were tested in 
various animal model for autoimmune disorder studies. They also reported the secretion have both 
immunostimulant and immunosuppression action, it varies by its dosage strength. [32]   
In animal studies reports, after organ transplantation in serotonin administered animal survive while compare with 
control group. [33]  

Because serotonin reduces the secretion of cytokines and decreases the TNF-alpha, TNF-gamma, IL-2, 
IL-7. Especially the drug fluoxetine drug of SSRIs suppress the T-cell mediation. [33]   
Antidepressants can affects the activity of various immune cells by improve the reuptake of serotonin which leads 
to lower the concentration in the environment of lymphocytes and also decrease the ability of proliferate. The 
immunomodulatory studies of SSRI was performed in animals and reported by Di Rosso et.al in 2016. [34]  
 
ROLE OF IL-17 AND Th17 LYMPHOCYTES IN AUTOIMMUNE DISEASE 

In 1989 Mosmann and Coffman described the relationship between the functional properties of Th1 and 
Th2 cells and cytokines produced by them. In 1995 Yao. Et al reveal the Th17 cell are able to produce IL17. In 
IL17 there are six known isoforms A to F. But, Th17 cell produce only IL17A and IL17F. These two are 
responsible for pro-inflammatory cytokines.  In Tph ( T peripheral helper cells) mice with arthritis, a significant 
increase in osteoclast differentiation and bone resorption was observed with increase in IL-17 levels in the paws 
and Th17 lymphocytes in draining lymph nodes, whereas T-regulatory cells were dampened. [35]  
It leads to cause the:  
• Rheumatoid arthritis.  
• Psoriasis.  
• Juvenile idiopathic arthritis. 
• Crohn’s disease.  
 

AUTOIMMUNE DISEASE IN SYSTEMIC 
Substantial progression in understanding of Th17 development and the effects of IL17 signaling in 

immune response as revealed their potential role in human autoimmune disease. It systemic autoimmune disease 
are in majority characterized by the loss of B cells control production of auto antibodies and formation of immune 
complexes, which contribute to tissue damage.  

 
AUTOIMMUNE DISEASE IN ORGAN SPECIFIC 

The autoimmune organ specific disease are mediated by specific immune response directed against 
antigen characteristic for particular tissue. The role Th1 and Th2 in the type of disorder was quite well established 
Th17 seems to be a new player in organ specific auto immunity. [36]  

 
SEROTONIN REGULATES THE Th1 AND Th2 CELLS TO INHIBIT THE CYTOKINE 

PRODUCTION IN-VITRO STUDIES 
The MS patients polyclonally activated PBMC culture CD4+ T-cells produce IL-17, TNF-gamma 

factors, it leads inflammation. The 5HT have ability to reduce the production of IL-17, TNF-gamma factors. 
Mainly, the Th17 cell produces TFN-gamma was reduced by 5HT. [37]  
 

ANIMAL STUDIES OF SELECTIVE SEROTONIN INHIBITORS IN IMMUNOSUPPRESSION:  
The SSRIs have majorly two mechanism for immune response suppression,  
• In autoimmune disease it suppresses the unwanted immune response.  
• It also produce immunosuppression by inhibit the T-cell response after transplantation.  

The mice were immunized and after 36 days it will sacrificed. The cytokine secretion of each mouse was 
collected from one paw in their whole joint. The dissected paw immersed up in a lysis buffer and the content of 
cytokine determined. The Enzyme linked immunosorbent assay method was used to measure the TNF-beta, Il-17, 
IL-17, IL-4, IL-6 in picogram per milliliter.  The RORγt expression in T-cell CD4+ lymphocytes was analysed 
after 5HT administration. The report states that the level of RORγt expression in CD4+ was reduced by using 5-
HT2A and 5-HT2B agonist in mice. [32] This review shows the complex involved in serotonin influences of 
immune cell. No matter of the serotonin derives from platelets, mast cells, T-cells or even from neurons. It 
influences disease like gut inflammation, allergic asthma, RA and neuroinflammation such ALS and autism. In 
the recent years, we could observe the anti-inflammatory effects and anti-depressant in clinical practice. [38]  

 

CONCLUSION 
 

RORγt antagonist may inhibit the proliferation of autoimmune disease and it provides new strategies for 
treatment of Th17 mediated immune disease. RORγt’s action inhibited by some ligand molecules in autoimmune 
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disease condition by suppressing the Th17 cells. Thus, SSRIs acts as RORγt antagonist to inhibit the inflammation 
and improve health in autoimmune hepatic jaundice.  

 

REFERENCES 
 
1. https://doi.org/10.1002/9780470015902.a0020193  
2. Yu C, Gershwin ME, Chang C. Diagnostic criteria for systemic lupus erythematosus: a critical review. J 

Autoimmun. 2014 Feb-Mar;48-49:10-3. doi: 10.1016/j.jaut.2014.01.004. Epub 2014 Jan 21. PMID: 
24461385.  

3. Smith DA, Germolec DR. Introduction to immunology and autoimmunity. Environ Health Perspect. 1999 
Oct;107 Suppl 5(Suppl 5):661-5. doi: 10.1289/ehp.99107s5661. PMID: 10502528; PMCID: 
PMC1566249.  

4. Invernizzi P, Gershwin ME. The genetics of human autoimmune disease. J Autoimmun. 2009 Nov-
Dec;33(3-4):290-9. doi: 10.1016/j.jaut.2009.07.008. Epub 2009 Aug 13. PMID: 19682858.  

5. https://www.niehs.nih.gov/health/topics/conditions/autoimmune  
6. Bogdanos DP, Smyk DS, Rigopoulou EI, Mytilinaiou MG, Heneghan MA, Selmi C, Gershwin ME. Twin 

studies in autoimmune disease: genetics, gender and environment. J Autoimmun. 2012 May;38(2-3):J156-
69. doi: 10.1016/j.jaut.2011.11.003. Epub 2011 Dec 15. PMID: 22177232.  

7. https://www.uptodate.com/contents/autoimmune-hepatitis-beyond-thebasics/print  
8. Manns MP, Czaja AJ, Gorham JD, Krawitt EL, Mieli-Vergani G, Vergani D, Vierling JM; American 

Association for the Study of Liver Diseases. Diagnosis and management of autoimmune hepatitis. 
Hepatology. 2010 Jun;51(6):2193213. doi: 10.1002/hep.23584. PMID: 20513004.  

9. https://www.sciencedirect.com/science/article/pii/S0168827810011852  
10. Roche SP, Kobos R. Jaundice in the adult patient. Am Fam Physician. 2004 Jan 15;69(2):299-304. PMID: 

14765767.  
11. Leung TS, Outlaw F, MacDonald LW, Meek J. Jaundice Eye Color Index (JECI): quantifying the 

yellowness of the sclera in jaundiced neonates with digital photography. Biomed Opt Express. 2019 Feb 
14;10(3):1250-1256. doi: 10.1364/BOE.10.001250. PMID: 30891343; PMCID: PMC6420273.  

12. Schwarzenbach HR. Ikterus und pathologische Leberwerte [Jaundice and pathological liver values]. Praxis 
(Bern 1994). 2013 Jun 5;102(12):727-9. German. doi: 10.1024/1661-8157/a001333. PMID: 23735764.  

13. Hinds TD Jr, Stec DE. Bilirubin, a Cardiometabolic Signaling Molecule.  Hypertension. 2018 Oct;72(4): 
788-795.  doi: 10.1161/Hypertensionaha.118.11130.  

14. Ngashangva L, Bachu V, Goswami P. Development of new methods for determination of bilirubin. J 
Pharm Biomed Anal. 2019 Jan 5;162:272-285. doi: 10.1016/j.jpba.2018.09.034. Epub 2018 Sep 18. PMID: 
30273817.  

15. Drummond GS, Kappas A. Chemoprevention of severe neonatal hyperbilirubinemia. Semin Perinatol. 
2004 Oct;28(5):365-8. doi: 10.1053/j.semperi.2004.09.004. PMID: 15686268.  

16. Kamisako T, Kobayashi Y, Takeuchi K, Ishihara T, Higuchi K, Tanaka Y. Recent advances in bilirubin 
metabolism research: the molecular mechanism of hepatocyte bilirubin transport and its clinical relevance. 
J Gastroenterol. 2000;35(9):659-64.  

17. https://www.medicalnewstoday.com/articles/165749  
18. https://www.uptodate.com/contents/autoimmune-hepatitis-beyond-thebasics/print  
19. https://www.practo.com/health-wiki/jaundice-symptoms-complications-andtreatment/79/article#2  
20. https://www.webmd.com/hepatitis/jaundice-why-happens-adults  
21. Yu W, Li C, Zhang D, Li Z, Xia P, Liu X, Cai X, Yang P, Ling J, Zhang J, Zhang M, Yu P. Advances in 

T Cells Based on Inflammation in Metabolic Diseases. Cells. 2022 Nov 10;11(22):3554. doi: 
10.3390/cells11223554. PMID: 36428983; PMCID: PMC9688178.  

22. Covelli C, Sacchi D, Sarcognato S, Cazzagon N, Grillo F, Baciorri F, Fanni D, Cacciatore M, Maffeis V, 
Guido M. Pathology of autoimmune hepatitis. Pathologica. 2021 Jun;113(3):185-193. doi: 10.32074/1591-
951X-241. PMID: 34294936; PMCID: PMC8299324.  

23. Tan J, Liu H, Huang M, Li N, Tang S, Meng J, Tang S, Zhou H, Kijlstra A, Yang P, Hou S. Small molecules 
targeting RORγt inhibit autoimmune disease by suppressing Th17 cell differentiation. Cell Death Dis. 2020 
Aug 22;11(8):697. doi: 10.1038/s41419-020-02891-2. PMID: 32829384; PMCID: PMC7443190.  

24. Rizvi SM, Shakil S, Haneef M. A simple click by click protocol to perform docking: AutoDock 4.2 made 
easy for non-bioinformaticians. EXCLI J. 2013 Sep 23;12:831-57. PMID: 26648810; PMCID: 
PMC4669947.  

25. Harrington, L. E., Hatton, R. D., Mangan, P. R., Turner, H., Murphy, T. L., Murphy, K. M., & Weaver, C. 
T. (2005). Interleukin 17-producing CD4+ effector T cells develop via a lineage distinct from the T helper 
type 1 and 2 lineages. Nature Immunology, 6(11), 1123-1132. doi: 10.1038/ni1254.  



M. Manjula et al / Int. J. of Pharmacy and Analytical Research. 14(1) 2025 [135-145] 

 

145 

 

26. Ivanov, I. I., McKenzie, B. S., Zhou, L., Tadokoro, C. E., Lepelley, A., Lafaille, J. J., ... & Littman, D. R. 
(2006). The orphan nuclear receptor RORγt directs the differentiation program of proinflammatory IL-17+ 
T helper cells. Cell, 126(6), 1121-1133. doi: 10.1016/j.cell.2006.07.035.  

27. Yu JJ, Gaffen SL. (2008). Interleukin-17: a novel inflammatory cytokine that bridges innate and adaptive 
immunity. Front Biosci, 13, 170-177. doi: 10.2741/2692.  

28. Yao Z, Fanslow WC, Seldin MF, Rousseau AM, Painter SL, Comeau MR, Cohen JI, Spriggs MK. (1995). 
Herpesvirus Saimiri encodes a new cytokine, IL-17, which binds to a novel cytokine receptor. Immunity, 
3(6), 811-821. doi: 10.1016/1074-7613(95)90070-5.  

29. Umar, Haruna & Adeola, Ajayi & Josiah, Sunday & Saliu, Tolulope & Bala Danjuma, Jamilu & 
Chukwuemeka, Prosper. (2020). In silico molecular docking of selected polyphenols against interleukin-
17A target in gouty arthritis. European Journal of Biological Research. 10. 352-367. 
10.5281/zenodo.4064236.   

30. Nandan A, Sharma V, Banerjee P, Sadasivam K, Venkatesan S, Prasher B. Deciphering the mechanism of 
Tinospora cordifolia extract on Th17 cells through in-depth transcriptomic profiling and in silico analysis. 
Front Pharmacol. 2023 Jan 9;13:1056677. doi: 10.3389/fphar.2022.1056677. PMID: 36699055; PMCID: 
PMC9868420.  

31. Berger M, Gray JA, Roth BL. The expanded biology of serotonin. Annu Rev Med. 2009;60:355-66. doi: 
10.1146/annurev.med.60.042307.110802. PMID: 19630576; PMCID: PMC5864293.  

32. Chabbi-Achengli Y, Coman T, Collet C, Callebert J, Corcelli M, Lin H, Rignault R, Dy M, de Vernejoul 
MC, Côté F. Serotonin Is Involved in Autoimmune Arthritis through Th17 Immunity and Bone Resorption. 
Am J Pathol. 2016 Apr;186(4):927-37. doi: 10.1016/j.ajpath.2015.11.018. Epub 2016 Mar 8. PMID: 
26968113.  

33. Veerle Gobin, Katleen Van Steendam, Damiaan Denys, Dieter Deforce, Selective serotonin reuptake 
inhibitors as a novel class of immunosuppressants, International Immunopharmacology, Volume 20, Issue 
1, 2014, Pages 148-156,ISSN 1567-5769.  

34. Szałach ŁP, Lisowska KA, Cubała WJ. The Influence of Antidepressants on the Immune System. Arch 
Immunol Ther Exp (Warsz). 2019 Jun;67(3):143151. doi: 10.1007/s00005-019-00543-8. Epub 2019 Apr 
29. PMID: 31032529; PMCID: PMC6509093.  

35. Anne Roumier, Catherine BÃ©chade, Luc Maroteaux, Chapter 10 - Serotonin and the Immune System, 
Editor(s): Paul M Pilowsky, Serotonin, Academic Press, 2019, Pages 181-196, ISBN 9780128000502, 
https://doi.org/10.1016/B978-0-12-800050-2.00010-3.  

36. Tabarkiewicz J, Pogoda K, Karczmarczyk A, Pozarowski P, Giannopoulos K. The Role of IL-17 and Th17 
Lymphocytes in Autoimmune Diseases. Arch Immunol Ther Exp (Warsz). 2015 Dec;63(6):435-49. doi: 
10.1007/s00005-015-0344-z. Epub 2015 Jun 11. PMID: 26062902; PMCID: PMC463344  

37. Sacramento PM, etal.,. Serotonin decreases the production of Th1/Th17 cytokines and elevates the 
frequency of regulatory CD4+ T-cell subsets in multiple sclerosis patients. Eur J Immunol. 2018 
Aug;48(8):1376-1388. doi: 10.1002/eji.201847525. Epub 2018 Jun 6. PMID: 29719048.  

38. Herr N, Bode C, Duerschmied D. The Effects of Serotonin in Immune Cells. Front Cardiovasc Med. 2017 
Jul 20;4:48. doi: 10.3389/fcvm.2017.00048. PMID: 28775986; PMCID: PMC5517399.  

  


